Chapter 4. Spreadsheets

We’ve discussed rather briefly the use of computer algebra in §3.5.

The approach of relying on www.wolframalpha.com is a poor subsititute for a full-
featured computer algebra program running on your own computer, one reason being the inability
to store intermediate results in www . wolframalpha . com. This means the power arising from
multi-step calculations, and the possibility of writing your own reusable programs inside the
system is lacking.

We will now discuss the idea of a spreadsheet and some simple applications.

4.1 A little on Spreadsheets

Spreadsheets are computer versions of an accounts ledger. They are used frequently in business,
but have wider uses. In particular they are often used to manipulate experimental data (in some
fields other tools are more often used) and you may encounter them in your labs. The idea then
is to give you a rudimentary knowledge of spreadsheets so that you may know where to start if
you need to use one in the lab.

First where do you find a spreadsheet programme to use? People usually assume that you
have one on your computer, called Microsoft Excel, and maybe even use the word “Excel” rather
than “spreadsheet”. However, if you have a computer at home it would possibly have cost you
extra to get Excel (and PowerPoint) for it. I think you need Microsoft Office Professional to
get them, at least if you got your computer after some date like the year 2000. At one stage
Windows computers tended to have all this software on them whether you really wanted them
or not, but that is no longer automatic. And Macintosh or Linux computers possibly won’t have
Excel (again unless someone takes care to get it). The PCs and Macs in the College computer
labs do have Excel.

There are alternatives to Excel that do more or less the same job, at least up to some level
of sophistication. I think LibreOffoce or OpenOffice are good options. You can download one
or the other for free from www.libreoffice.org or www.openoffice.orqg and that
will give you a replacement for Microsoft Office (Word, Excel and Powerpoint at least; it can
read and write [most] files from Microsoft programmes). For a Mac you might find Neoffice
www .neooffice.org best. I suppose downloading these is easy if you have a good network
connection, but they are quite big.

There are other options too, including several other spreadsheet programs that you don’t have
to pay for.

The option we will discuss is using a Google spreadsheet online, which is offered as part of
the Google Drive the facility of gmai 1/e-mail service. (As your TCD email account is on gmail,
you have access to Google spreadsheets. Click on the Drive item at the top of the screen when
logged in, then CREATE a new Spreadsheet to get started.)

As far as I can see the facilities provided by Google spreadsheets are convenient to use and
adequate at least for discovering the basic ideas. Maybe not all statistical tools are as readily
available as on Excel (for example).


www.wolframalpha.com
www.wolframalpha.com
www.libreoffice.org
www.openoffice.org
www.neooffice.org
gmail

2 2012-13 Mathematics MA1S11 (Timoney)

4.2 What a spreadsheet looks like

When you start a spreadsheet programme (with nothing saved from before) you should see a
grid like the one in the next picture. There are various menu items across the top, various magic
shortcut icons around the top an/or side, and the essence of the thing is the grid. The rows of
the grid are numbered 1, 2, 3, and so on, while the columns are labels A, B, C, etc. You would
normally see a bigger number of rows and columns than what is shown here.
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The little tabs at the bottom called sheets allow you to have several pages, like in a ledger
book, with separate or related stuff on the other sheets. But we will just try to explain what you
can do sticking with one sheet.

In the picture the top left box, the one in Column A and Row 1, is highlighted (or selected), as
indicated by the blackened square around that box, and also you can see Al written somewhere
above. What you can do is put stuff in the different boxes. We call these boxes cells of the
spreadsheet and the (main) things you can put in these cells are

(1) a number
(i) a word or some words, or any text

(ii1) a formula
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In this way it is like a ledger book you might have seen someone use for accounts, except
that the formula option is different. You might think the boxes are too small to enter much text
but you can resize the columns (make them wider or narrower) by dragging with your mouse on
the boundary between columns across the top (where the A, B, C, etc. are). You can also make a
row deeper, or get the thing to ‘wrap’ lines in a cell and then resize rows automatically to fit the
deepest cell in that row.

You do these things with the Format — Cells menu item in several programmes (but Google
Drive has a rather different Format — Number selection). To get the line to wrap under itself at
word breaks, you pick the ‘Alignment’ tab in that menu and check the box for ‘Automatic line
break’. (Google Drive wraps anyhow.)

But to get some words in (or a number) just type the number with some particular cell se-
lected. Type Return or press Tab when you are done.

You can move round to different cells by clicking on them with the mouse, or with arrow
keys.

The real power of a spreadsheet comes from the ability to enter formulae into cells, and
the possibility that the formulae can read values out of other cells. The first rule is that a cell
beginning with an equals sign is interpreted as a formula. (If you happen to try entering text
that begins with an equals sign, such as =Total you will get a peculiar outcome, indicating an
error.) If you type in, say =5+6 (and press return), 11 will show in the cell. When you click on
the cell, the actual formula will still be there, but it looks just like you typed in the 11 for the rest
of the time.

You can put arithmetic formulae using + for addition, — for subtraction, = for multiplica-
tion, / for division and ~ for “to the power of”. You use round brackets for grouping. So
=(5+6/9) 8 will come out to 45.33333333. You can also use lots of standard functions,
too many to list here. The notation is like =sin (1.2) although the function names are case-
insensitive (so that =SIN (1.2) and =Sin (1.2) will do the same).

The real advantage of a spreadsheet is that formulae and functions can refer to values entered
in (or computed) in other cells. So say in cell B5 (meaning the one in column B, row 5) we have
entered in 1. 2) and then in cell D5 we enter in =sin (B5). Cell D5 will then show the value
of sin 1.2 (which is 0.932039). But if you later change the entry in B35, the value in cell D5 will
automatically change accordingly.

Another helpful thing is how copy and paste works. If you want to replicate what is in cell
B5 all the way down column B, from cell B6 to B15, this is what you can do. Highlight (or click
on) cell B5. Using the Edit menu, copy that cell (or just use the keyboard shortcut Control-C).
Then drag your mouse from cell B6 down to cell B15. When you let up the mouse button those
cells will still be highlighted. Press Paste (in the Edit menu, or the keyboard shortcut Control-V)
and what is in cell B5 will be copied into each of the positions B6 down to B15.

Now if, as seems to be the case above, cell BS just contains a fixed value 1 . 2, this is a minor
convenience. Easier than retyping the number 1. 2 ten times. (If you did it in cells B6 down to
cell B105 it would save you typing 1.2 a hundred times.) But, now comes the value of what is
called ‘relative references’. Suppose we copy cell D5 (where we had entered =sin (B5) ) in the
same way, and paste it into cells D6 down to cell D15. What goes into the cells is then changed
so that the reference is changed in each one. In cell D6, it will become the formula =sin (B6),
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on the grounds that B6 is in the same position (2 cells left) relative to cell D6 as cell B5 is to
cell Dé.

4.2.1 Example

Suppose we want to calculate the values of y = cos(z) for z = 0,7/10,27/10, ...,207/10 =
27. (Maybe we want these values for a graph.)

In fact for this kind of mathematical graph, spreadsheets are probably not what you should
use. But we’ll use it now for this anyhow.

Let’s enter this in the cells

L Al B |
0 | =cos (Al)

SO0 Q|| N | W N

p—

(Here the pi () is a way to get at the value m = 3.1415. . ..) This is what you will see

Il AlB]
1 01
2 1 0.31
3
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Now copy cell A2 and paste it into all the positions A3 to A21. And copy cell B1 and paste that
into all the positions B2 to B21. Just to clarify, the effect will be the same as if you had typed all
the formulae in the left side of the following, but what you see will be like the right.
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L Al Bl [ [Aa [B |
1 0 =cos (Al) 110 1
2 =Al + pi()/10 | =cos(A2) 21 0.31]0.95
3 =A2 + pi()/10 | =cos(A3) 31 0.63 | 0.81
4 =A3 + pi()/10| =cos(A4) 41094 | 0.59
5 =A4 + pi()/10| =cos(A5) 5| 1.26 | 0.31
6 =A5 + pi()/10 =cos (Ab6) 61115710
7 =A6 + pi()/10 =cos (A7) 71 1.88 | -0.31
8 =A7 + pi()/10 =cos (A8) 8122 |-0.59
9 =A8 + pi()/10| =cos(A9) 91 2.51|-0.81
10 =A9 + pi()/10 | =cos (A1l0) 10 || 2.83 | -0.95
21 | =A20 + pi()/10 | =cos (A21) 21 | 6.28 | 1

4.2.2 Graphs

Graphs (or charts) seem to me to work differently in different programs. With the Google version
and the above data, you could highlight cells A1 to B21 and click on the icon for a graph (or find
it in the Insert menu). You’ll then be presented with various types of graphs or charts to choose
from and the option to use column A as labels for one axis.

The Google spreadsheet will display 7 to more than two places by default. If you want ony
two displayed, use format on the cell (or click the ‘123 icon at the top with the cells highlighted).

4.3 Absolute references

We may sometimes want to refer to a fixed value, like a tax rate or a VAT rate in a spreadsheet.
Or maybe the concentration for some acid, or a PH value. But we might want to allow for that
value being changed, and then we want to be able to change our calculations accordingly.

We could find a place where we are going to put that value, say cell D2. We could enter 1. 23
into that cell for the multiplying factor to add VAT. Now in column A we might list a description
of various items we spent money on, in the next column B the cost before VAT of those things,
and in column C we might want the cost including VAT. We could enter in cell C1 the formula
=B1x1.23 and copy that down column C. That would work, but if we have to change the VAT
rate we would have to alter all the formulae. If we put =B1+D2 in cell C1, and copy that to cell
C2, it will become =B2 xD 3, but that is not what we want. We want to get the value in B2 times
the value in D2.

This can be done by inserting in cell C1 the formula =B1+$D$2. The $D$2 reference stays
as $D$2 even after it is copied and pasted. So now if we paste that into cell C2, it will become
=B2x$D$2, and still refer to the constant 1.23 we have entered in cell D2.

Let’s say we create this spreadsheet,
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L A B | C| D |
1 Item | Cost ex VAT | Cost inc VAT | VAT Rate
2 Door 97.32 =B2%x3$DS$2 1.23
3 Lock 23.55 =B3x$DS$2
4 || Brass handle 18.35 =B4*x$DS$2
5 Hinges 15.19 =B5%S$DS$S2
6 =B6xS$DS2
7 =B7x$DS$2
8 =B8x$DS2
9 =B9x$DS$2
10 TOTAL | =sum (B2:B9) =sum (C2:C9)

where we are showing what was typed into each cell. However, cells C3 to C9 could be arrived
at by copying and pasting from cell C2. It would not save you much, but cell C10 could also be
got by copying and pasting from cell C9.

The result you would see on the screen would look something like this:

L Al B | C| D |
1 Item | Cost ex VAT | Costinc VAT | VAT Rate
2 Door 97.32 117.76 1.23
3 Lock 23.55 28.5
4 || Brass handle 18.35 22.2
5 Hinges 15.19 18.38
6 0
7 0
8 0
9 0

10 TOTAL 154.41 186.84

You might fill in further items and their costs into columns A and B (rows 6 to 9 are still free).
As you do that the totals will be updated. Changing the VAT rate entry 1.23 would change the
numbers in column C.

You might also want to adjust the formatting on the cells B2 to C10 to show 2 decimal places
and a perhaps a currency symbol. There are too many tricks you can do to even pretend to tell
you about them.

4.4 Further features

As mentioned already, spreadsheets can do such a range of things that we can’t really hope to
convey many of the finer points.

About functions that spreadsheets know about. There are really lots, too many to try and
explain. Anyhow we don’t have the background to understand them all (especially those related
to statistics). Here is a small selection
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cos(), sin(), exp(), ... Lots of mathematical functions. exp(x) means e”. cos(X) is the cos x we
use in calculus (with x in radians).

sum() Adds up the numerical values in the range. Could be =sum (A1:B10, C3)
average() Divides the sum of the numerical values in the range by the number of them.

count() Counts how many numerical values there are in the range.

So=sum (A1:B10) /count (Al1:B10) should be the same as =average (A1:B10)

counta() Counts how many not blank entries there are in the range. So a cell with text in it will
count.

max(), min() Picks the largest (smallest for min) value among those you feed it.

if() This allow for complicated things.
A simple example is the formula =IF (A2>39, "Pass","Fail")

It means if the value if A2 is more than 39, then put the word Pass. If not, put the word
Fail. Instead of words, you could have formulae. You could programme a rule that charges
20% tax up to 1500 euro and 40% on anything above like this

=IF (A2>1500, 0.2%x1500 +0.4% (A2-1500), 0.2%xA2)

4.4.1 Matrix operations

Matrix-valued functions seem mysterious to work in some spreadsheet programs but in Google
they seem quite easy.

For instance the MINVERSE () and MMULT () functions work quite well. You need to feed
the MINVERSE () a range of rows and columns that make a square matrix. It produces er-
ror codes if the matrix has no inverse. For MMULT () you need to feed it two blocks so that
the sizes of the blocks make up matrices that can be multiplied. For instance the formula
=mmult (A2:C3,A2:A4) will multiply the 3 X 2 matrix given by the entries in the block
A2 to C3 times the 3 x 1 block (column) given by the numbers in A2 to A4.

The SUMPRODUCT () function can do dot products and there is a TRANSPOSE () to do
matrix transposes. Later you may find it useful to know about MDETERM () (which finds deter-
minants).

4.5 Help

There are help menus in all spreadsheets I've seen recently and there are also menus you can put
up showing all the available functions (of which there are a few hundred predefined).

Richard M. Timoney December 7, 2012
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